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Module 1: Introduction to Articulate Storyline 
 

Objective: 

 

 

By the end of this module, participants will be able to :  

• navigate the Articulate Storyline interface  

• create a new project with appropriate settings  

• understand the key concepts of project properties, story size, and publishing 

options  
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1.1 Welcome and Course Overview 
In this opening section, we'll introduce you to our Articulate Storyline Quick Start Course and provide an 

overview of what you can expect to learn throughout the day. 

Slide Notes 

• Begin by welcoming the participants to the Articulate Storyline Quick Start Course. 

• Express enthusiasm for their presence and eagerness to learn. 

• Mention the course duration and the importance of their active participation throughout the 

day. 
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1.1.1 Course Objectives 
▪ Understanding the Storyline interface 

▪ Creating interactive slides 

▪ Working with triggers and actions 

▪ Building quizzes and assessments 

▪ Publishing and deployment options 
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1.1.2 Agenda 

•  Outline the schedule for the day, providing participants with a clear roadmap of what topics will 

be covered and when. For example 

o Morning Session Introduction to Articulate Storyline 

o Afternoon Session Building Interactive Content 

o Wrapping Up and Q&A 

• Mention breaks and mealtimes to ensure participants are aware of the schedule. 

  



 

©2024 Public Information Limited, LLC. 

1.1.3 Housekeeping 

•  Cover logistical details such as 

o Restroom locations 

o Emergency exits 

o Contact information for course facilitators 

o WiFi access (if applicable) 

•  Encourage participants to raise their hand or use a designated signal if they have questions or 

need assistance at any time during the course. 
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1.1.4 Participant Introductions 

• Depending on the size of the group, you may choose to have participants introduce themselves 

briefly.  

o They can share their names, backgrounds, and what they hope to achieve from the 

course. 

o This can help create a sense of community and engagement among participants. 

• Conclude the slide by expressing excitement for the day ahead and the valuable skills 

participants will gain.  

• Reiterate that the course is designed to be hands on and interactive, ensuring a practical learning 

experience. 

Slide Transition 

With our course introduction complete, let's dive into the first module of the day "Introduction to 

Articulate Storyline." In the next slide, we'll start by exploring the basics of the Storyline interface. 
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1.2 Understanding the Storyline Interface 
In this section, we will delve into the various components of the Articulate Storyline interface. 

Understanding these elements is crucial as they form the foundation for creating interactive eLearning 

content. 

Slide Notes 

• Start by emphasizing the importance of understanding the Storyline interface, as it's the 

workspace where participants will be creating their eLearning courses. 

o 1.2.1 The Ribbon 

▪ Introduce "The Ribbon" as one of the primary components of the interface. 

▪ Explain that The Ribbon contains tabs, each of which groups related functions 

together. 

▪ Highlight key tabs like Home, Insert, Design, Transitions, Animations, Review, and 

View, and briefly mention their functions. 

▪ Emphasize that The Ribbon is context sensitive, meaning its options change 

based on the task you're performing. 

o 1.2.2 Slide View 

▪ Transition to discussing Slide View, another critical part of the interface. 

▪ Describe Slide View as the workspace where participants design and edit 

individual slides. 

▪ Mention that participants can access Slide View by double clicking on a slide in 

the Slide Panel or by clicking "Edit Slide" on the Ribbon. 

▪ Highlight the components within Slide View, including the slide workspace, slide 

timeline, scene navigation, and slide properties. 

o 1.2.3 Timeline (Next Slide) 

▪ Let participants know that we'll dive deeper into the "Timeline" in the next slide. 

▪ Explain that the Timeline is a visual representation of the objects on a slide and 

their timing. 

▪ Briefly mention its role in managing object timing, layering, and animation 

effects. 

o 1.2.4 Scenes (Continued Slide Notes) 

▪ Conclude this slide by letting participants know that we'll explore "Scenes" in the 

subsequent slide. 

▪ Describe Scenes as organizational tools for structuring eLearning projects into 

sections or chapters. 

▪ Explain how Scenes help in keeping courses organized and provide a logical flow 

for learners. 

▪ Encourage participants to follow along and ask questions as we explore these 

interface components. 

▪ Emphasize that a solid understanding of the interface will make it easier for 

participants to navigate and create engaging eLearning content. 

Slide Transition 
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 In the next slide, we'll dive deeper into "The Ribbon" to explore its tabs and command groups in more 

detail. Understanding these tools will empower participants to create and design their eLearning courses 

effectively. 
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1.2.1 The Ribbon 
In this section, we'll explore one of the fundamental components of the Articulate Storyline interface, 

which is "The Ribbon." The Ribbon is a vital tool for accessing various features and options to create and 

enhance your eLearning courses. 

Slide Notes 

• The Ribbon is located at the top of the Articulate Storyline window. 

• It is organized into tabs, each of which groups related functions together. These tabs include 

Home, Insert, Design, Transitions, Animations, Review, and View. 

• Within each tab, you'll find various command groups. For example, within the Home tab, you'll 

find groups like Clipboard, Slides, and Editing. 

• The Ribbon is context sensitive, meaning the available options change depending on what you're 

currently working on. For instance, when you select a slide or an object on the slide, you'll see 

different options on the Ribbon compared to when you're working with the overall project. 

• Let's take a closer look at some of the key tabs and command groups in the Ribbon 

Home Tab 

• The Home tab contains essential commands for working with your slides and slide content. 

• In the Clipboard group, you can find commands like Cut, Copy, and Paste for managing your 

content. 

• The Slides group allows you to add, duplicate, or delete slides and access slide layout options. 

• The Editing group provides tools for formatting text, aligning objects, and managing states and 

triggers. 

Insert Tab 

• The Insert tab is where you go to add various elements to your slides. 

• You can insert new slides, characters, pictures, audio, video, shapes, and more. 

• The functionality of this tab is crucial for building engaging eLearning content. 

Design Tab 

• The Design tab lets you control the overall look and feel of your course. 

• You can change the slide master, apply themes, and adjust fonts and colors. 

• Customizing the design is essential for branding and creating visually appealing courses. 

• In summary, the Ribbon is your gateway to all the tools and features you'll need to create 

interactive eLearning courses in Articulate Storyline. 

• As we progress through the course, we'll dive deeper into the specific functions and options 

available within the Ribbon tabs and groups. 

• Feel free to ask questions during our hands-on exercises and discussions to ensure you're 

comfortable navigating and using the Ribbon effectively. 

Slide Transition 

Let's now move on to exploring the next component of the Storyline interface. In the next slide, we will 

delve into "Slide View" and how it complements the Ribbon for building your eLearning projects.  



 

©2024 Public Information Limited, LLC. 

1.2.2 Slide View 
In this section, we'll explore another crucial aspect of the Articulate Storyline interface—Slide View. 

Understanding Slide View is essential for creating, designing, and editing individual slides in your 

eLearning courses. 

Slide Notes 

• Slide View is one of the primary workspaces within Articulate Storyline, allowing you to focus on 

designing and editing individual slides. 

• To access Slide View, you can either double click on a slide in the Slide Panel or click on the slide 

thumbnail and then click the "Edit Slide" button on the Ribbon's Home tab. 

• Once you're in Slide View, you'll notice several key components 

Slide Workspace 

• The central area is your slide workspace. This is where you build the content for your slide. You 

can add and arrange text, images, shapes, buttons, and other multimedia elements here. 

• You can also work with slide layers and states in this workspace to create interactivity and 

animations. 

Slide Timeline 

• The Slide Timeline is typically located at the bottom of the Slide View. It provides a visual 

representation of the objects on your slide and their timing. 

• Objects on the timeline are stacked in the order they appear on the slide. You can adjust their 

timing, layers, and animation effects here. 

Scene Navigation 

• In the lower left corner, you'll see scene navigation controls. These allow you to move between 

different slides and scenes in your project quickly. 

• You can also use the Scene Panel on the left side of the interface to manage and organize your 

slides and scenes. 

Slide Properties 

•  On the right side of the Slide View, you'll find the Slide Properties panel. This panel allows you to 

set slide specific properties, such as slide transitions, slide backgrounds, and slide size. 

•  Slide Properties are important for customizing the behavior and appearance of individual slides. 

• Slide View is where you'll spend most of your time when designing and developing eLearning 

content. It provides you with the tools and workspace needed to create engaging and interactive 

slides. 

• As we progress through the course, we'll dive deeper into working with objects, layers, and 

states within Slide View to create more interactive and dynamic eLearning modules. 

• Feel free to ask questions as we go along, and don't hesitate to explore the various features in 

Slide View to get comfortable with this essential aspect of Articulate Storyline. 

Slide Transition 
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Now that we've covered Slide View, let's move on to the next section where we'll discuss the "Timeline" 

in more detail and explore how it can be used to manage the timing and animations of objects on your 

slides. 
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1.2.3 Timeline 
In this section, we'll explore the Timeline, a critical component of Articulate Storyline that helps you 

manage the timing, arrangement, and animation of objects on your slides. Understanding how the 

Timeline works is essential for creating dynamic and interactive eLearning content. 

Slide Notes 

• The Timeline is a visual representation of the objects on your slide and their timing and layering. 

• It is typically located at the bottom of the Slide View workspace. 

• The Timeline is organized vertically, with objects appearing as horizontal bars on the timeline. 

• Each object's position on the timeline indicates when it appears and how long it stays on the 

slide. 

• Key aspects of the Timeline include 

Object Bars 

• Objects, such as text boxes, images, shapes, and buttons, are represented as bars on the 

Timeline. 

• You can click on an object bar to select and manipulate the object on the slide. 

• The order of object bars on the timeline determines their stacking order on the slide. Objects at 

the top of the timeline are in front of objects below them. 

Timing Indicators 

• The Timeline shows timing indicators that represent the start and end points of an object's 

appearance on the slide. 

• You can drag these indicators to adjust when an object enters and exits the slide. 

Layering 

• Objects on the Timeline can be organized into layers. Layers control the order in which objects 

appear and interact on the slide. 

• Objects on higher layers are in front of objects on lower layers. 

• You can use the "Arrange" options on the Ribbon to change an object's layer. 

Animation Effects 

• The Timeline also displays animation effects applied to objects. You can see animation triggers 

and their timing on the timeline. 

• You can adjust the timing and duration of animations by dragging animation triggers on the 

timeline. 

• The Timeline is a powerful tool for controlling the timing and visual effects of your eLearning 

content. You can use it to synchronize audio narration, create interactive animations, and 

manage the flow of information on your slides. 

• In the upcoming hands-on exercises, we'll practice working with the Timeline to animate objects, 

control object visibility, and create interactive scenarios. 

Slide Transition 
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Now that we've covered the essentials of the Timeline, let's continue to explore the various features and 

tools within Slide View. In the next section, we'll delve into "Scenes" and learn how they can be used to 

organize and structure your eLearning projects. 
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1.2.4 Scenes 
In this section, we'll explore the concept of "Scenes" in Articulate Storyline. Scenes are a powerful 

organizational tool that allows you to structure your eLearning course into sections or chapters. 

Understanding how to use Scenes effectively can help you create well organized and cohesive eLearning 

projects. 

Slide Notes 

• Scenes are a way to organize and structure your eLearning project into distinct sections or 

chapters. 

•  You can think of Scenes as containers that hold a group of related slides. For example, in a 

compliance training course, you might have scenes for Introduction, Policies, Quiz, and 

Conclusion. 

• Key aspects of Scenes include 

Creating Scenes 

• To create a new scene, go to the "Story View" or "Slide View" and click the "New Scene" button 

or right click in the Scenes panel and choose "New Scene." 

• Give your scene a descriptive name that reflects its content or purpose. 

Managing Slides in Scenes 

• Once you have scenes created, you can drag and drop individual slides into the appropriate 

scene. 

• This helps you keep your slides organized and makes it easier to navigate a large project. 

Navigating Between Scenes 

• You can use the Scenes panel on the left side of the interface to navigate between scenes. 

• Clicking on a scene in the panel takes you to that scene in Slide View. 

Scene Properties 

• Each scene has its own properties, which you can access by right clicking on the scene in the 

Scenes panel and selecting "Scene Properties." 

•  Scene properties allow you to set options like transitions between scenes and the navigation 

buttons available to learners. 

• Scenes are particularly useful when you have a course with multiple chapters or sections. They 

provide a clear structure to your project and help you maintain an organized workflow. 

• In addition to improving project organization, scenes can also impact the learner's experience by 

allowing you to control how learners navigate through your course. 

• As you gain experience with Articulate Storyline, you'll find that scenes are a valuable tool for 

designing courses that are both visually appealing and logically structured. 

Slide Transition 

Now that we've covered Scenes, let's move on to the next section where we'll explore how to create a 

new project in Articulate Storyline, including setting project properties and choosing story size. 
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1.3 Creating a New Project 
In this section, we'll explore the essential steps to create a new project in Articulate Storyline. Setting up 

your project correctly at the beginning is crucial for a smooth course development process. 

Slide Notes 

• Start by highlighting the importance of setting up a new project correctly. Mention that this step 

lays the foundation for the entire eLearning course. 

• 1.3.1 Setting Project Properties 

o Begin by explaining that the first step in creating a new project is setting project 

properties. 

o Project properties include details such as the project's title, author, and description. 

o Emphasize that these properties help identify and manage the project effectively. 

• 1.3.2 Choosing Story Size 

o Transition to the next point, which is choosing the story size for your project. 

o Explain that the story size defines the dimensions of your eLearning course, including 

width and height. 

o Mention that you can select a predefined size or create a custom size based on your 

specific needs. 

o Conclude this slide by highlighting the importance of paying attention to project 

properties and story size before starting a project. 

o Explain that these initial settings can save time and ensure your course is properly 

configured from the beginning. 

Slide Transition 

In the next section, we'll explore "Saving and Publishing Options." Understanding how to save your work 

and choose publishing settings is crucial for sharing your eLearning course with others. 
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1.3.1 Setting Project Properties 
In this section, we will explore the importance of defining project properties when creating a new 

eLearning project in Articulate Storyline. Properly configuring these properties is essential for project 

organization and management. 

Slide Notes 

• Begin by explaining the significance of setting project properties. These properties help you and 

your team manage the eLearning project effectively from start to finish. 

Project Properties 

•  Describe project properties as key details about the project itself. This includes information like 

the project title, author, and description. 

•  Emphasize that these properties serve as a reference for project identification and 

documentation. 

Steps to Set Project Properties 

1. Project Title Explain that you should start by providing a clear and descriptive title for your project. 

This title helps you and your team identify the project easily. 

2. Author Mention that you should specify the author's name or the name of the course creator. This 

information can be important for attribution and accountability. 

3. Description Encourage participants to provide a brief description of the project's purpose or content. 

This description can help others understand the project's scope and objectives. 

Benefits of Setting Project Properties 

• Highlight the advantages of defining project properties 

o Organization Properly documented project properties make it easier to organize and 

categorize projects, especially in a collaborative environment. 

o Version Control Project properties can help you keep track of different versions of your 

eLearning courses. 

o Attribution They provide clear attribution to the author or creator of the course, which 

can be important for credit and accountability. 

Slide Transition 

In the next section, we'll explore the second part of creating a new project, which is "Choosing Story 

Size." The story size determines the dimensions of your eLearning course, and understanding how to 

choose the right size is essential for creating engaging content. 

 

  



 

©2024 Public Information Limited, LLC. 

1.3.2 Choosing Story Size 
In this section, we'll explore how to select the appropriate story size when creating a new eLearning 

project in Articulate Storyline. The story size determines the dimensions of your course and is crucial for 

optimizing the learning experience. 

Slide Notes 

• Begin by explaining the importance of choosing the right story size. This setting directly impacts 

how your eLearning course will be displayed and experienced by learners. 

What is Story Size 

• Describe "Story Size" as the dimensions (width and height) of your eLearning course's slides. 

• Emphasize that the choice of story size depends on factors like your audience, device 

compatibility, and content type. 

Predefined Story Sizes 

• Mention that Articulate Storyline offers several predefined story sizes that you can choose from. 

These sizes are optimized for different devices and screen resolutions. 

• Explain that you can select from options like "Standard (43)," "Wide (169)," and "Custom" sizes. 

Custom Story Size 

• Explain that if none of the predefined sizes fit your requirements, you can create a custom story 

size. 

• Describe how to input specific width and height dimensions to tailor the course size to your 

needs. 

Considerations for Choosing Story Size 

• Share considerations for selecting the right story size 

• Audience Consider the devices your learners will use. Are they primarily on desktop computers, 

tablets, or smartphones? 

• Content Think about the type of content you'll be delivering. Rich media content may require 

larger dimensions. 

• Design Consider the visual design and layout of your course. Some designs work better with 

specific aspect ratios. 

Slide Transition 

In the next section, we'll move forward with "Saving and Publishing Options." Understanding how to 

save your work and configure publishing settings is crucial for sharing your eLearning course effectively. 
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1.4 Saving and Publishing Options 
In this section, we will explore the essential steps for saving your work and configuring publishing 

options in Articulate Storyline. Properly saving and publishing your eLearning project is crucial for 

sharing it with your intended audience. 

Slide Notes 

Begin by emphasizing the importance of saving and publishing options. These steps are essential to 

ensure your eLearning course reaches your learners effectively. 

• Saving Your Work 

o Start by explaining the importance of saving your work regularly as you create your 

eLearning course. 

o Emphasize that saving ensures you don't lose any progress in case of unexpected 

interruptions or technical issues. 

• How to Save Your Project 

o Describe the process of saving a project 

o Go to the "File" tab on the Ribbon. 

o Select "Save" or "Save As" if you want to save a copy with a different name or location. 

o Choose the desired location on your computer or network and provide a meaningful 

filename. 

• Publishing Options Overview 

o Transition to the next point by introducing the concept of publishing. 

o Explain that publishing involves preparing your eLearning course for delivery to your 

audience, whether it's on the web, a learning management system (LMS), or offline. 

• Common Publishing Options 

o Highlight common publishing options available in Articulate Storyline, including 

o Web For publishing courses to be hosted on a website or shared via a link. 

o LMS For integration with a Learning Management System, commonly used in corporate 

training. 

o CD/DVD For exporting the course to physical media for offline viewing. 

o Word For exporting the course content into a Word document. 

Slide Transition 

In the next section, we'll delve into a more detailed exploration of the specific publishing options, 

including configuring settings for web and LMS publishing. These settings play a crucial role in how your 

course functions and tracks learner progress.  
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1.4.1 Saving Your Work 
In this section, we'll explore the importance of saving your work regularly when working on an eLearning 

project in Articulate Storyline. Saving your work is a fundamental practice to prevent data loss and 

ensure a smooth workflow. 

Slide Notes 

Start by emphasizing the critical importance of saving your work throughout the course development 

process. It's a simple yet crucial practice that can save you from potential data loss and setbacks. 

Why Save Your Work 

• Explain why saving your work is essential 

• Data Loss Prevention Saving prevents the loss of your work in case of unexpected interruptions, 

software crashes, or technical issues. 

• Version Control It helps you maintain different versions of your project, useful for tracking 

changes or reverting to previous states if needed. 

• Collaboration If you're working with a team, saving ensures everyone is working with the latest 

version of the project. 

How to Save Your Project 

• Describe the step-by-step process of saving a project 

1. Click on the "File" tab in the Ribbon. 

2. Select "Save" if you've already saved the project before, or "Save As" if it's a new project or you want 

to save a copy with a different name or location. 

3. Choose the destination folder on your computer or network and provide a meaningful filename. 

4. Click "Save" to confirm. 

Best Practices for Saving 

• Share some best practices for saving work effectively 

o Set Auto-Save Consider configuring auto-save settings in Articulate Storyline to save 

your work at regular intervals automatically. 

o Incremental File Names When using "Save As," consider adding version numbers or 

timestamps to the filename to differentiate between different project versions. 

o Backup Regularly Consider making regular backups of your project files to an external 

drive or cloud storage for added security. 

o Conclude the slide by reiterating the significance of saving work regularly throughout 

the course development process to ensure a smooth and efficient workflow. 

Slide Transition 

In the next section, we'll explore "Publishing Options Overview," where we'll discuss how to prepare and 

deliver your eLearning course to your audience effectively. 
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1.4.2 Publishing Options Overview 
In this section, we will explore the concept of publishing your eLearning project in Articulate Storyline. 

Understanding the different publishing options and their purposes is essential for delivering your course 

to your target audience. 

Slide Notes 

• Start by explaining the significance of the publishing process. It's the final step in course 

development that makes your eLearning content accessible to learners. 

What is Publishing 

• Define "Publishing" as the process of preparing your eLearning project for delivery to your audience. 

It involves packaging the course content in a format that learners can access. 

Common Publishing Options 

• Highlight the common publishing options available in Articulate Storyline. These include 

• Web Publishing for online access via a web browser. Suitable for web hosting or sharing via a link. 

• LMS (Learning Management System) Publishing for integration with a Learning Management 

System, commonly used in corporate and educational settings. 

• CD/DVD Exporting the course to physical media for offline viewing, often used for training in remote 

or offline environments. 

• Word Exporting the course content into a Word document, useful for creating documentation or job 

aids. 

Choosing the Right Publishing Option 

• Discuss the importance of choosing the appropriate publishing option based on your audience, 

delivery method, and learning objectives. 

• Mention that each publishing option has specific settings and considerations that need to be 

configured. 

Slide Transition 

In the next section, we'll dive deeper into specific publishing options, including configuring settings for 

web and LMS publishing. Understanding these settings is crucial for delivering and tracking your 

eLearning content. 
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Hands on Exercise 1: Create a Blank Project and Explore the Interface 
In this exercise, you will create a blank project in Articulate Storyline and become familiar with the 

interface components discussed earlier in the course, including The Ribbon, Slide View, Timeline, and 

Scenes. 

Instructions 

1. Open Articulate Storyline 

• Launch Articulate Storyline on your computer if you haven't already. 

2. Create a New Blank Project 

• Click on the "File" tab in the top-left corner of the interface to access the File menu. 

• Select "New Project" to create a new blank project. 

3. Set Project Properties 

• After creating the new project, a dialog box may appear to set project properties such as the title, 

author, and description. Fill in these details as instructed by the facilitator. This step simulates what 

we discussed in Subsection 1.3.1. 

4. Choose Story Size 

• Once you've set the project properties, the new project will open in Slide View. 

• You can now choose the story size for your project. You can either select one of the predefined sizes 

(e.g., Standard, Wide) or create a custom size based on your preferences. This step simulates what 

we discussed in Subsection 1.3.2. 

5. Explore the Interface 

• Spend some time exploring the interface components discussed in Module 1, including 

• The Ribbon Navigate through the different tabs and command groups in The Ribbon. Observe how 

the options change based on the task you're performing. 

• Slide View Click on various slides in the Slide Panel and explore Slide View. Pay attention to the slide 

workspace, timeline, scene navigation, and slide properties. 

• Timeline Click on an object on a slide to select it and observe how it appears on the timeline. Notice 

how you can adjust the object's timing and duration. 

• Scenes If your project includes multiple scenes, use the Scenes panel on the left side of the interface 

to navigate between scenes. 

7. Save Your Work 

• Before concluding the exercise, practice saving your work. Click on the "File" tab in The Ribbon and 

select "Save" or "Save As" to save your project. Follow the prompts to choose a location and provide 

a filename. 

8. Exercise Completion 

• Notify the facilitator once you've completed the exercise and explored the interface components 

thoroughly. 
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Conclusion 
This hands-on exercise provides you with practical experience in creating a new project in Articulate 

Storyline, setting project properties, choosing the story size, and exploring the key components of the 

interface. These skills are foundational to using Articulate Storyline effectively for eLearning course 

development. 
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Module 2: Building Your First Slide 
 

Objective: 

 

 

After completing this module, participants will have the skills to :  

• create interactive slides by adding and formatting text, inserting images and media  

• working with shapes and buttons  

• using layers and states effectively  
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2.1 Adding and Formatting Text 
Subtitle Crafting Engaging Text Elements 

Description: In this section, we will explore how to add and format text on your eLearning slide. Text is a 

fundamental element in course design, and mastering its use is crucial for effective communication. 

Slide Notes 

• Start Subsection 2.1 by emphasizing the importance of text in eLearning courses. 

• Explain that text is often used to convey information, instructions, and feedback to learners. 

• Mention that participants will learn how to add, format, and style text elements on their slides 

during this section. 

Key Points 

2.1.1. Text Importance  

• Highlight the significance of text in eLearning. 

• Explain that well-crafted text can make complex concepts understandable and engaging. 

2.1.2. Adding Text 

• Describe how to add text to a slide 

o Select the "Text" or "Text Box" tool from the Ribbon. 

o Click on the slide where you want to add text. 

o Start typing or paste your content into the text box. 

2.1.3. Text Formatting 

• Discuss the importance of text formatting for readability and aesthetics. 

• Mention that participants will learn how to: 

o Change font styles, sizes, and colors. 

o Adjust paragraph alignment. 

o Apply bullet points and numbering. 

o Utilize bold, italics, and underline for emphasis. 

2.1.4. Text Styles 

• Introduce the concept of text styles or presets. 

• Explain that styles allow for consistent formatting across the course. 

• Demonstrate how to create and apply text styles. 

Slide Transition 

In the next section, Subsection 2.2, we'll explore "Inserting Images and Media." Visual elements like 

images, audio, and video play a crucial role in engaging learners, and we'll learn how to incorporate 

them effectively. 
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2.2 Inserting Images and Media 
Subtitle Visual Engagement 

Description Visual elements like images, audio, and video can enhance the learning experience. In this 

subsection, we'll explore how to insert and manage media assets in your eLearning project. 

Slide Notes 

• Start Subsection 2.2 by highlighting the importance of visual engagement in eLearning. 

• Explain that multimedia elements like images and media can make the content more engaging 

and effective. 

• Mention that participants will learn how to import images, add audio and video, and manage 

these assets effectively. 

Key Points 

1. Visual Engagement 

• Emphasize the role of visual elements in capturing learners' attention and enhancing 

comprehension. 

• Share examples of how images, audio, and video can be used effectively in eLearning. 

2. Importing Images 

• Explain the process of importing images into your eLearning project: 

o Click on the "Insert" tab in The Ribbon. 

o Select "Picture" to browse for and add an image to your slide. 

o Discuss image formats (e.g., JPEG, PNG) and their suitability for different scenarios. 

3. Adding Audio and Video 

• Describe how to add audio and video to your eLearning course: 

o Use the "Audio" and "Video" tools in The Ribbon. 

o Mention supported audio and video formats. 

o Explain how to set playback options, such as autoplay and controls. 

4. Media Management 

• Discuss best practices for managing media assets in your project: 

o Organize media files in a dedicated folder. 

o Use descriptive filenames. 

o Consider copyright and licensing issues when using external media. 

Slide Transition 

In the next section, Subsection 2.3, we'll explore "Working with Shapes and Buttons." Interactivity is a 

key aspect of eLearning, and we'll learn how to create interactive elements that engage learners and 

facilitate navigation.  
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2.2.1 Importing Images 
Subtitle Enhancing Visuals 

Description In this subsection, we'll explore the process of importing images into your eLearning project. 

Visual elements play a significant role in engaging learners, and adding images is a fundamental skill in 

course design. 

Slide Notes 

• Begin Subsection 2.2.1 by emphasizing the importance of visual elements in eLearning. 

• Explain that images, in particular, can enhance engagement, clarify concepts, and make content 

more visually appealing. 

• Mention that participants will learn how to import images into their eLearning projects during 

this section. 

Key Points 

1. Role of Images 

• Highlight the importance of images in eLearning courses. 

• Explain how images can be used to: 

o Illustrate concepts. 

o Enhance storytelling. 

• Create visual interest. 

2. Importing Images 

• Describe the process of importing images into Articulate Storyline 

o Click on the "Insert" tab in The Ribbon. 

o Select "Picture" to browse for and add an image to your slide. 

• Discuss image formats (e.g., JPEG, PNG) and their suitability for different scenarios. 

3. Image Considerations 

• Share tips and considerations when using images in eLearning 

o Source of images (e.g., stock photos, custom illustrations). 

o Image resolution for clarity. 

o Copyright and licensing for image usage. 

Slide Transition 

In the next section, Subsection 2.2.2, we'll explore "Adding Audio and Video." Multimedia elements like 

audio and video can further enhance the learning experience, and participants will learn how to 

incorporate them effectively. 
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2.2.2 Adding Audio and Video 
Subtitle Enhancing Multimedia 

Description In this subsection, we'll explore how to add audio and video to your eLearning project. 

Multimedia elements can greatly enhance the learning experience, and mastering their use is essential 

for effective course design. 

Slide Notes 

• Begin Subsection 2.2.2 by highlighting the importance of multimedia elements in eLearning. 

• Explain that audio and video can provide additional context, engage different senses, and make 

content more engaging. 

• Mention that participants will learn how to add and manage audio and video elements during 

this section. 

Key Points 

1. Benefits of Multimedia 

• Emphasize the advantages of using audio and video in eLearning: 

o Enhancing engagement. 

o Demonstrating processes. 

o Providing real-world examples. 

2. Adding Audio 

Describe how to add audio to your eLearning course: 

• Click on the "Insert" tab in The Ribbon. 

• Select "Audio" to browse for and add an audio file. 

• Discuss supported audio formats (e.g., MP3, WAV) and their suitability. 

3. Adding Video 

• Explain the process of adding video to your eLearning course: 

o Click on the "Insert" tab in The Ribbon. 

o Select "Video" to browse for and add a video file. 

• Mention supported video formats (e.g., MP4, FLV) and their compatibility. 

4. Setting Playback Options 

• Discuss playback options for audio and video elements: 

o Autoplay Whether the media should start automatically when the slide is viewed. 

o Controls Whether playback controls (play, pause, volume) should be visible to learners. 

• Conclude the slide by highlighting the importance of multimedia elements in eLearning and the 

practical skills participants will gain in this section. 

Slide Transition 
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In the next section, Subsection 2.3, we'll explore "Working with Shapes and Buttons." Interactivity is a 

key aspect of eLearning, and participants will learn how to create interactive elements that engage 

learners and facilitate navigation. 
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2.3 Working with Shapes and Buttons 
Subtitle Interaction and Navigation 

Description Interactivity is a key aspect of eLearning. In this section, we'll explore how to use shapes and 

buttons to create interactive elements that engage learners and facilitate navigation. 

Slide Notes 

• Begin Subsection 2.3 by emphasizing the importance of interactivity in eLearning. 

• Explain that shapes and buttons are versatile tools for creating interactive elements. 

• Mention that participants will learn how to use shapes and buttons to enhance learner 

engagement and navigation. 

Key Points 
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2.3.1. Interactivity in eLearning 

•  Emphasize the value of interactivity in keeping learners engaged and facilitating comprehension. 

•  Discuss how interactive elements can be used for quizzes, navigation, and scenario-based 

learning. 
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2.3.2. Using Shapes 

• Explain how to add and customize shapes on your eLearning slide 

o Click on the "Insert" tab in The Ribbon. 

o Select "Shape" to choose from various shapes like rectangles, circles, and arrows. 

• Discuss options for customizing shape fill, outline, and effects. 
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2.3.3. Creating Buttons 

• Describe the process of creating interactive buttons: 

o Use shapes or convert existing objects into buttons. 

o Discuss the importance of clear button labeling. 

• Explain how to assign actions or triggers to buttons. 
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2.3.4. Button States 

• Introduce the concept of button states (e.g., Normal, Hover, Clicked): 

o Explain how states allow buttons to change appearance and behavior. 

• Discuss common uses for button states in eLearning. 

• Conclude the slide by highlighting the importance of interactivity and navigation in eLearning 

and the practical skills participants will gain in this section. 

Slide Transition 

In the next section, Subsection 2.4, we'll explore "Layers and States." Layers and states add depth to your 

eLearning content, and we'll learn how to use them to create dynamic and interactive slides. 
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2.4 Layers and States 
Subtitle Dynamic Content 

Description: Layers and states add depth to your eLearning content. In this subsection, we'll explore how 

to use layers and states to create dynamic and interactive slides. 

Slide Notes 

• Begin Subsection 2.4 by introducing the concept of layers and states as tools for creating 

dynamic content. 

• Explain that layers and states allow for the display of additional content and interaction beyond 

the base slide. 

• Mention that participants will learn how to create and customize layers and states to make their 

courses more engaging and interactive. 

Key Points 

  



 

©2024 Public Information Limited, LLC. 

2.4.1. Understanding Layers 

• Define layers as additional content or information that can be displayed on a slide. 

• Explain that layers can be used for pop-up information, feedback, or branching scenarios. 
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2.4.2. Creating Layers 

• Describe the process of creating layers: 

o Select a slide and go to the "Insert" tab in The Ribbon. 

o Choose "New Layer" to create a new layer. 

o Explain that each layer can have its own content, text, images, and interactivity. 
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2.4.3. States for Interactivity 

• Introduce states as variations of an object's appearance and behavior. 

• Explain that states can be used for interactive elements, such as buttons and characters. 

• Mention that common states include Normal, Hover, Clicked, and Disabled. 
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2.4.4. Customizing States 

• Discuss how to customize object states: 

o Select an object, go to the "States" panel, and edit the states as needed. 

o Emphasize the importance of clear visual cues for learners. 

• Conclude the slide by highlighting the potential for creativity and interactivity that layers and 

states offer in eLearning courses and the practical skills participants will gain in this section. 

Slide Transition 

In the next module, Module 3, we'll explore "Storyline's Powerful Features." Participants will delve into 

triggers, actions, variables, slide transitions, and animations, gaining a deeper understanding of how to 

create interactive and engaging eLearning content. 
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Hands on Exercise 2: Create a Simple Interactive Slide 
In this exercise, you will create a simple interactive slide in Articulate Storyline. You will practice adding 

interactive elements like buttons and customizing their states and triggers to engage learners effectively. 

Instructions 

1. Open Your Existing Project 

• Launch Articulate Storyline on your computer if it's not already open. 

• Open the project you've been working on during this training course. If you haven't started a 

project yet, you can continue from where you left off in the previous hands-on exercise. 

2. Select a Slide 

• Choose an existing slide where you want to create your simple interactive slide. This can be any 

slide you've been working on. 

3. Create Interactive Elements 

• On the selected slide, create two or more interactive elements using shapes or buttons. These 

elements can represent navigation options, quiz choices, or any scenario-based interaction. 

• Add labels or text to these elements to provide context or instructions. 

4. Customize Button States 

• Select one of the interactive elements (e.g., a button). 

• In the "States" panel, customize the states for this element. Create at least three states, 

including "Normal," "Hover," and "Clicked." You can also add a custom state if it suits your 

interaction. 

5. Add Actions or Triggers 

• Assign actions or triggers to the interactive elements. For example, when a learner clicks a 

button, you might want something to happen, like showing a layer with additional information. 

• Use the "Triggers" panel to create these actions. You can choose actions like "Show Layer," 

"Jump to Slide," or "Change State" depending on your interaction. 

6. Test Your Interactive Slide 

• Preview your slide to test the interactive elements and make sure they behave as intended. 

• Check that the states change correctly when you hover over or click on the elements. 

• Confirm that the assigned actions or triggers work as expected. 

7. Adjust and Refine 

• If necessary, make adjustments to your interactive slide. Fine-tune the appearance, interactions, 

or states to ensure a seamless learning experience. 

8. Save Your Project 

• Don't forget to save your project to retain the changes you've made during this exercise. 

9. Exercise Completion 

• Notify the facilitator or instructor once you've completed the exercise and have successfully 

created a simple interactive slide. 
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Conclusion 
This hands-on exercise allows you to practice creating interactive slides in Articulate Storyline. Interactive 

elements, customized states, and triggers are essential tools for engaging learners and enhancing the 

learning experience in your eLearning courses. 
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Module 3: Storyline's Powerful Features 
 

Objective: 

 

 

At the conclusion of this module, participants will be proficient in :  

• using triggers, actions, and variables to create interactivity in their projects  

• apply slide transitions and animations  

• develop engaging eLearning content  
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3.1 Triggers and Actions 
Subtitle Creating Interactivity 

Description In this subsection, we'll explore the fundamentals of triggers and actions in Articulate 

Storyline. Understanding how to use triggers and actions is essential for creating interactive and 

engaging eLearning content. 

Slide Notes 

• Begin Subsection 3.1 by emphasizing the importance of triggers and actions in eLearning. 

• Explain that triggers and actions allow for the creation of interactivity, enabling learners to 

engage with content in meaningful ways. 

• Mention that participants will learn the basics of triggers and common actions during this 

section. 

Key Points 

1. Triggers Explained 

• Define triggers as events that initiate actions. 

• Emphasize that triggers are the building blocks of interactivity. 

• Mention that triggers can be based on learner actions (e.g., clicking a button) or timeline events 

(e.g., reaching a specific time point). 

2. Common Actions 

• Discuss some common actions that can be triggered: 

o Show/hide objects or layers. 

o Jump to a specific slide or scene. 

o Change the state of an object. 

o Adjust variable values. 

o Play or pause media. 

3. Triggers Panel 

• Introduce the Triggers panel in Articulate Storyline. 

• Explain that this panel is where you create, edit, and manage triggers for your slide objects. 

4. Adding Triggers 

• Describe how to add triggers to objects: 

o Select an object. 

o Open the Triggers panel. 

o Click "Add Trigger" and define the trigger's conditions and actions. 

Slide Transition 

In the next subsection, Subsection 3.2, we'll explore "Variables." Variables add a layer of complexity to 

interactions, allowing you to create more dynamic and personalized eLearning experiences.  
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3.1.1 Understanding Triggers 
Subtitle Building Interactivity 

Description In this subsection, we'll delve deeper into the concept of triggers in Articulate Storyline. 

Understanding how triggers work is essential for creating interactive and engaging eLearning content. 

Slide Notes 

• Begin Subsection 3.1.1 by building upon the importance of triggers and actions introduced in the 

previous slide. 

• Explain that triggers are the backbone of interactivity in eLearning, and participants will gain a 

deeper understanding of how they function. 

• Mention that participants will learn about trigger components, including the event, condition, 

and action. 

Key Points 

1. Trigger Components 

• Break down the components of a trigger: 

o Event Explain that an event is the action or occurrence that initiates the trigger. It could 

be a learner clicking a button, hovering over an object, or reaching a specific point on 

the timeline. 

o Condition Describe conditions as optional criteria that must be met for a trigger to 

execute. Conditions can add complexity to interactions. 

o Action Define actions as the specific responses or behaviors triggered by an event. 

Common actions include showing/hiding objects, jumping to slides, or changing object 

states. 

2. Event Examples 

• Provide examples of common events in eLearning: 

o Click Triggered when a learner clicks on an object. 

o Hover Triggered when a learner hovers the mouse over an object. 

o Timeline Start/End Triggered when the timeline reaches a specific point. 

3. Condition Use Cases 

• Explain when conditions are useful: 

o Branching Scenarios Conditions can be used to create branching scenarios where the 

course path depends on learner choices. 

o Assessments Conditions can be used to evaluate quiz responses and provide customized 

feedback. 

4. Action Variety 

• Highlight the variety of actions that can be executed: 

o Show/Hide Objects can be shown or hidden based on learner actions. 
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o Jump to Slide Learners can be directed to different slides or scenes. 

o Change State Objects can change appearance or behavior (e.g., from normal to selected) 

based on triggers. 

Slide Transition 

In the next subsection, Subsection 3.1.2, we'll explore "Common Actions." Participants will learn about 

frequently used actions and how to implement them effectively in their eLearning courses. 
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3.1.2 Common Actions 
Subtitle Enhancing Interactivity 

Description In this subsection, we'll explore some common actions that can be triggered in Articulate 

Storyline. Understanding these actions is crucial for creating engaging and interactive eLearning content. 

Slide Notes 

• Begin Subsection 3.1.2 by emphasizing the practical importance of common actions in eLearning 

design. 

• Explain that participants will learn about frequently used actions that can enhance engagement 

and interactivity in their courses. 

• Mention that participants will gain insights into how to implement these actions effectively. 

Key Points 

1. Show and Hide Actions 

• Explain the utility of "Show" and "Hide" actions: 

o Show Used to display objects, layers, or content when triggered. Useful for revealing 

information, feedback, or additional content. 

o Hide Used to conceal objects or content when triggered. Helpful for tidying up the 

interface or removing information. 

2. Jump to Slide Action 

• Describe the "Jump to Slide" action: 

o Allows learners to navigate to a specific slide or scene when triggered. 

o Useful for creating branching scenarios, navigation buttons, or menus. 

3. Change State Action 

• Explain the "Change State" action: 

o Used to modify the appearance or behavior of objects based on triggers. 

o Common states include "Normal," "Hover," "Selected," and "Visited." 

4. Adjust Variable Action 

• Discuss the "Adjust Variable" action: 

o Enables you to change the value of a variable when triggered. 

o Useful for tracking progress, scores, or custom interactions. 

5. Play Media Action 

• Describe the "Play Media" action: 

o Initiates the playback of audio or video when triggered. 

o Allows for synchronized media elements in eLearning. 

Slide Transition 
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In the next subsection, Subsection 3.2, we'll explore "Variables." Participants will learn how to use 

variables for more advanced interactivity and personalization in eLearning courses. 
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3.2 Variables 
Subtitle Advanced Interactivity 

Description In this subsection, we'll explore the concept of variables in Articulate Storyline. Variables are 

a powerful tool for creating dynamic and personalized eLearning experiences. 

Slide Notes 

• Begin Subsection 3.2 by introducing the concept of variables as a means to achieve advanced 

interactivity in eLearning. 

• Explain that variables allow you to store, track, and manipulate data, enabling personalized and 

responsive course experiences. 

• Mention that participants will learn about variable types and practical use cases during this 

section. 

Key Points 

1. What Are Variables? 

• Define variables as containers that hold data values. 

• Explain that variables can store information like numbers, text, or True/False values. 

• Emphasize that variables can be used to track progress, scores, learner choices, and more. 

2. Types of Variables 

• Discuss different variable types: 

o Number Variables Used for storing numeric values (e.g., scores, percentages). 

o Text Variables Used for storing text-based information (e.g., learner names). 

o True/False Variables Used for tracking binary conditions (e.g., completion status). 

3. Practical Use Cases 

• Share practical scenarios where variables are beneficial: 

o Progress Tracking Variables can be used to track and display progress. 

o Quiz Scores Variables can tally quiz scores and provide feedback. 

o Personalization Variables enable personalized experiences based on learner choices. 

o Branching Scenarios Variables can determine the course path. 

4. Working with Variables 

• Explain how to create, modify, and reference variables: 

o Access the "Variables" panel in Articulate Storyline. 

o Create new variables and define their initial values. 

o Use triggers to adjust variable values based on learner actions. 

Slide Transition 
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In the next subsection, Subsection 3.3, we'll explore "Slide Transitions and Animation." Participants will 

learn how to add transitions and animations to make their eLearning content more engaging and visually 

appealing. 
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3.2.1 Introduction to Variables 
Certainly, here are detailed slide notes for Module 3, Subsection 3.2.1 "Introduction to Variables" in your 

Articulate Storyline Intermediate Level Course 

Subtitle Harnessing Data 

Description In this subsection, we'll take a closer look at the concept of variables in Articulate Storyline. 

Variables are essential for creating dynamic and personalized eLearning experiences, and this slide 

introduces you to the fundamentals. 

Slide Notes 

• Begin Subsection 3.2.1 by emphasizing the significance of variables in creating engaging and 

personalized eLearning courses. 

• Explain that variables are data containers that can store, track, and manipulate information, 

making eLearning content more interactive and responsive. 

• Mention that participants will gain a foundational understanding of variables in this section. 

Key Points 

1. What Are Variables? 

• Define variables as data containers that hold information. 

• Explain that variables can store various types of data, such as numbers, text, and True/False 

values. 

• Emphasize that variables are used to make eLearning content more dynamic and personalized. 

2. Variable Types 

• Describe different types of variables: 

o Number Variables Used for numeric data like scores, percentages, and counts. 

o Text Variables Used for storing and displaying text-based information. 

o True/False Variables Used for tracking binary conditions (e.g., completion status). 

3. Use Cases 

• Share practical scenarios where variables play a crucial role: 

o Progress Tracking Variables can track and display progress within a course. 

o Quiz Scores Variables can tally quiz scores and provide feedback. 

o Personalization Variables enable content personalization based on learner choices. 

o Branching Scenarios Variables can determine the course path. 

Slide Transition 

In the next subsection, Subsection 3.2.2, we'll explore "Variable Types." Participants will learn about the 

specific characteristics and use cases of different variable types, deepening their understanding of 

variable usage. 
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3.2.2 Variable Types 
Subtitle Understanding Variability 

Description In this subsection, we'll explore different types of variables in Articulate Storyline. 

Understanding variable types is essential for tailoring eLearning experiences to meet specific needs. 

Slide Notes 

• Begin Subsection 3.2.2 by emphasizing the importance of understanding variable types for 

creating personalized and interactive eLearning courses. 

• Explain that different variable types serve distinct purposes, and participants will learn how to 

use them effectively. 

• Mention that participants will explore number variables, text variables, and True/False variables 

in this section. 

Key Points 

1. Number Variables 

• Define number variables as containers for numeric data. 

• Explain that number variables are commonly used for: 

o Tracking scores and percentages. 

o Counting learner interactions. 

o Calculating values based on learner input. 

2. Text Variables 

• Describe text variables as containers for text-based information. 

• Highlight that text variables are valuable for: 

o Personalizing content with learner names. 

o Displaying dynamic text, instructions, or feedback. 

o Customizing scenarios and dialogues. 

3. True/False Variables 

• Explain True/False variables as binary containers for conditions. 

• Emphasize that True/False variables are useful for: 

o Tracking completion status (e.g., whether a module is completed or not). 

o Managing conditional branching (e.g., directing learners based on choices). 

Use Cases 

• Share practical use cases for each variable type: 

o Number Variables Tracking quiz scores, calculating progress percentages, and counting 

the number of correct answers. 

o Text Variables Personalizing course greetings, displaying dynamic feedback, and tailoring 

scenarios to learner choices. 

o True/False Variables Determining completion status, controlling conditional branching, 

and managing on/off states. 
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Slide Transition 

In the next subsection, Subsection 3.3, we'll explore "Slide Transitions and Animation." Participants will 

learn how to add transitions and animations to make their eLearning content more engaging and visually 

appealing. 
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3.3 Slide Transitions and Animation 
Subtitle Enhancing Visual Engagement 

Description In this subsection, we'll explore how to use slide transitions and animation in Articulate 

Storyline. These techniques can greatly enhance the visual appeal and engagement of your eLearning 

content. 

Slide Notes 

• Begin Subsection 3.3 by highlighting the importance of visual engagement in eLearning. 

• Explain that slide transitions and animations are powerful tools for creating dynamic and visually 

appealing courses. 

• Mention that participants will learn how to apply transitions and animations effectively during 

this section. 

Key Points 

1. Slide Transitions 

• Define slide transitions as effects that occur when moving from one slide to another. 

• Explain that slide transitions add visual interest and smoothness to the course flow. 

• Mention that Articulate Storyline offers various transition options (e.g., fade, slide, flip) that can 

be customized. 

2. Animation Effects 

• Describe animation effects as movements or changes applied to objects or elements within a 

slide. 

• Emphasize that animations can draw learners' attention, clarify concepts, and provide visual 

cues. 

• Explain that Articulate Storyline provides a range of animation effects (e.g., entrance, exit, 

motion path) with customizable settings. 

3. Timing and Sequencing 

• Discuss the importance of timing and sequencing in slide transitions and animations. 

• Explain that precise timing can create a sense of rhythm and guide learner focus. 

• Mention that participants will learn how to set and adjust timing in Articulate Storyline. 

Slide Transition 

In the next subsection, Subsection 3.4, we'll explore "Assessments and Quizzes." Participants will learn 

how to create effective quizzes and assessments to evaluate learner progress and comprehension. 
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3.3.1 Applying Slide Transitions 
Subtitle Visual Enhancements 

Description In this subsection, we'll dive into the world of slide transitions in Articulate Storyline. 

Applying effective slide transitions can significantly enhance the visual appeal and engagement of your 

eLearning content. 

Slide Notes 

• Begin Subsection 3.3.1 by explaining the importance of slide transitions in creating visually 

engaging eLearning content. 

• Emphasize that well-chosen slide transitions can improve the flow and coherence of the course. 

• Mention that participants will learn how to apply and customize slide transitions during this 

section. 

Key Points 

1. Slide Transition Basics 

• Define slide transitions as visual effects applied when moving from one slide to another. 

• Explain that transitions create a sense of continuity and engagement in eLearning courses. 

• Mention that Articulate Storyline offers various transition options (e.g., fade, slide, flip) with 

adjustable settings. 

2. Choosing the Right Transition 

• Discuss considerations for selecting appropriate transitions: 

o Content and Tone Match transitions to the content and tone of the course. 

o Audience Consider the preferences and expectations of the target audience. 

o Consistency Maintain consistency in transition styles throughout the course. 

3. Customizing Transitions 

• Explain how to customize slide transitions in Articulate Storyline: 

o Access the "Transitions" panel. 

o Choose a transition effect and adjust its duration. 

o Preview transitions to ensure they align with the course's visual style. 

Slide Transition 

In the next subsection, Subsection 3.3.2, we'll explore "Animating Objects." Participants will learn how to 

apply animation effects to individual objects on slides, further enhancing engagement and visual 

storytelling. 
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3.3.2 Animating Objects 
Subtitle Enhancing Engagement 

Description In this subsection, we'll explore the world of object animation in Articulate Storyline. 

Animation can transform static content into engaging visual experiences, capturing learners' attention 

and improving comprehension. 

Slide Notes 

• Begin Subsection 3.3.2 by highlighting the significance of object animation in eLearning design. 

• Explain that animations add interactivity, clarity, and engagement to eLearning content. 

• Mention that participants will learn how to apply and customize animations to individual objects 

during this section. 

Key Points 

1. Object Animation Basics 

• Define object animation as the application of movement or changes to individual objects on a 

slide. 

• Explain that animations make content more dynamic and can emphasize key points. 

• Mention that Articulate Storyline offers a range of animation effects (e.g., entrance, exit, motion 

path) with customizable settings. 

2. Choosing the Right Animation 

• Discuss considerations for selecting appropriate animations: 

o Content Emphasis Choose animations that draw attention to important content. 

o Learning Objectives Align animations with the course's learning objectives. 

o Visual Cohesion Maintain visual consistency with other course elements. 

3. Customizing Animations 

• Explain how to customize object animations in Articulate Storyline: 

o Select an object and access the "Animations" panel. 

o Choose an animation effect and adjust its settings (e.g., speed, direction). 

o Preview animations to ensure they enhance the content. 

Slide Transition 

In the next subsection, Subsection 3.4, we'll explore "Assessments and Quizzes." Participants will learn 

how to create effective quizzes and assessments to evaluate learner progress and comprehension. 
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Hands on Exercise 3: Create an Interactive Scenario Using Triggers, Actions, and Variables 

Exercise Objective 
In this hands-on exercise, you will create an interactive scenario using triggers, actions, and variables in 

Articulate Storyline. The scenario will involve multiple decision points, and learners' choices will affect 

the outcome. 

Scenario Description 
You are designing an eLearning course for customer service representatives. The scenario involves a 

customer call where the representative must handle different situations. The learner's choices will 

determine the outcome of the call. 

Instructions 
1. Set Up the Slide 

• Create a new slide in Articulate Storyline. 

• Design the slide to resemble a phone call scenario. You can use images or shapes to represent 

the phone, the customer, and the representative. 

• Add text boxes for dialogues. The customer and representative should have their dialogues. 

2. Create Variables 

• Access the "Variables" panel in Articulate Storyline. 

• Create three variables `CustomerMood`, `ResponseTime`, and `CallOutcome`. 

• Set the initial values of these variables. For example, `CustomerMood` can be set to "Neutral," 

`ResponseTime` can be set to 0, and `CallOutcome` can be set to "Undecided." 

3. Add Interaction Elements 

• Insert buttons or clickable objects that represent response options for the customer service 

representative. 

• For example, you can add buttons like "Apologize," "Offer a Solution," and "Transfer to a 

Supervisor." 

• These buttons will trigger actions based on learner choices. 

4. Create Triggers 

• Access the "Triggers" panel in Articulate Storyline. 

• Create triggers for each response option button 

o When the "Apologize" button is clicked, adjust the `CustomerMood` variable to 

"Satisfied" and increase the `ResponseTime` variable by 1. 

o When the "Offer a Solution" button is clicked, adjust the `CustomerMood` variable to 

"Happy" and increase the `ResponseTime` variable by 2. 

o When the "Transfer to a Supervisor" button is clicked, adjust the `CustomerMood` 

variable to "Angry" and increase the `ResponseTime` variable by 3. 
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• Create additional triggers to check the value of the `ResponseTime` variable and set the 

`CallOutcome` variable based on specific time thresholds. For example, if `ResponseTime` is less 

than 5, set `CallOutcome` to "Successful." 

5. Display Feedback 

• Add text or graphics on the slide to provide feedback to learners based on their choices and the 

values of the variables. 

• Depending on the `CallOutcome` variable, display a message like "You successfully resolved the 

customer's issue" or "The call did not go well." 

6. Testing and Preview 

• Test the scenario by previewing the slide in Articulate Storyline. 

• Interact with the scenario by clicking the response option buttons to see how the variables and 

triggers work. 

7. Additional Complexity (Optional) 

• If you want to add more complexity, consider adding branching scenarios based on the 

`CustomerMood` variable. 

• For example, if `CustomerMood` is "Angry," you can create additional decision points and 

responses specific to angry customers. 

8. Save Your Work 

• Save your Articulate Storyline project to ensure you can revisit and edit the scenario later if 

needed. 

Conclusion 
By completing this hands-on exercise, you will have created an interactive scenario using triggers, 

actions, and variables in Articulate Storyline. This exercise helps you understand how to design branching 

scenarios that respond to learner choices and variables, enhancing the interactivity and engagement of 

your eLearning courses. 
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Module 4: Assessments and Quizzes 
 

Objective: 

 

 

Upon finishing this module, participants will be able to :  

• design quizzes with various question types  

• utilize question banks for efficiency  

• implement custom feedback to enhance the learner assessment experience  
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4.1 Building Quizzes 
Subtitle Assessing Knowledge 

Description: In this subsection, we'll explore how to create effective quizzes in Articulate Storyline. 

Quizzes are a valuable tool for assessing learner knowledge and comprehension. 

Slide Notes 

• Begin Subsection 4.1 by emphasizing the importance of quizzes in the eLearning context. 

• Explain that quizzes serve as a means to assess learner progress and comprehension. 

• Mention that participants will learn how to create engaging and effective quizzes during this 

section. 

Key Points 

1. Quiz Types 

• Introduce different types of quizzes learners can create in Articulate Storyline: 

o Multiple Choice Learners select the correct answer from a list of options. 

o True/False Learners indicate whether a statement is true or false. 

o Matching Learners match items from two columns. 

o Fill in the Blank Learners complete sentences or phrases with missing words. 

o Essay Learners provide open-ended written responses. 

o Drag and Drop Learners drag items to their correct locations. 

o Hotspot Learners click on specific areas of an image. 

o Survey Collect learner opinions or feedback without scoring. 

2. Question Design 

• Discuss best practices for designing quiz questions: 

o Clear and Concise Ensure questions are easy to understand. 

o Single Best Answer Avoid ambiguous questions with multiple correct answers. 

o Appropriate Feedback Provide feedback for correct and incorrect responses. 

o Randomization Consider randomizing answer choices to reduce memorization. 

3. Setting Scoring and Feedback 

• Explain how to set scoring options for quizzes: 

o Assign point values to each question. 

o Determine passing scores and completion criteria. 

o Specify feedback for correct and incorrect answers. 

4. Question Banks 

• Introduce the concept of question banks: 

o Explain that question banks allow for a pool of questions from which quizzes can draw 

randomly. 
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o Mention that using question banks helps prevent learners from memorizing quiz 

questions. 

Slide Transition 

In the next subsection, Subsection 4.2, we'll explore "Result Slides." Participants will learn how to design 

and customize result slides to provide feedback and track learner performance in quizzes. 
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4.1.1 Question Types 
Subtitle Designing Effective Questions 

Description In this subsection, we'll explore different question types that can be created in Articulate 

Storyline quizzes. Understanding these question types is crucial for designing effective assessments. 

Slide Notes 

• Begin Subsection 4.1.1 by emphasizing the importance of choosing the right question types for 

effective assessment. 

• Explain that the choice of question type depends on the learning objectives and the content 

being assessed. 

• Mention that participants will learn about various question types and their suitable applications 

during this section. 

Key Points 

1. Multiple Choice Questions (MCQs) 

• Explain that MCQs present a question with multiple answer choices, where learners select the 

correct one. 

• Mention that MCQs are effective for assessing knowledge of facts and concepts. 

• Highlight that Articulate Storyline allows for single or multiple correct answers in MCQs. 

2. True/False Questions 

• Describe true/false questions as statements where learners indicate whether the statement is 

true or false. 

• Mention that true/false questions are suitable for assessing factual knowledge or binary 

understanding. 

• Explain that they are often used to check learners' comprehension of key points. 

3. Matching Questions 

• Explain that matching questions involve pairs of items that learners need to match correctly. 

• Emphasize that matching questions are ideal for assessing associations and relationships 

between concepts. 

• Highlight that Articulate Storyline allows you to create matching questions with draggable items. 

4. Fill in the Blank Questions 

• Define fill in the blank questions as questions with missing words or phrases that learners need 

to complete. 

• Explain that fill in the blank questions assess the ability to recall specific terms or concepts. 

• Mention that they are useful for reinforcing vocabulary or terminology. 

5. Essay Questions 
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• Describe essay questions as open-ended questions that require learners to provide detailed 

written responses. 

• Explain that essay questions are valuable for assessing critical thinking and the ability to 

articulate ideas. 

• Mention that they are often used for longer, in-depth assessments. 

Slide Transition 

In the next subsection, Subsection 4.1.2, we'll explore "Creating Effective Questions." Participants will 

learn best practices for designing questions that effectively assess learner knowledge and 

comprehension. 
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4.1.2 Question Banks 
Subtitle Designing for Clarity and Assessment 

Description In this subsection, we'll delve into the art of creating effective questions for quizzes in 

Articulate Storyline. Well-designed questions are essential for accurate assessment and learner 

engagement. 

Slide Notes 

• Begin Subsection 4.1.2 by highlighting the critical role of question design in effective assessment. 

• Explain that well-structured questions ensure clarity and fair evaluation. 

• Mention that participants will learn best practices for creating questions that accurately assess 

learner knowledge and comprehension during this section. 

Key Points 

1. Clarity and Simplicity 

• Emphasize that questions should be clear and straightforward. 

• Avoid complex or convoluted language that may confuse learners. 

• Use simple sentence structures and concise wording. 

2. Avoid Ambiguity 

• Explain that ambiguous questions can lead to incorrect assessments. 

• Encourage participants to review questions for any potential ambiguity. 

• Provide examples of common sources of ambiguity to avoid. 

3. Use Correct Grammar and Spelling 

• Stress the importance of proper grammar and spelling in questions. 

• Explain that errors in language can distract learners and affect comprehension. 

• Suggest proofreading questions before adding them to quizzes. 

4. Balance Question Length 

• Discuss the importance of balancing question lengths. 

• Mention that some questions may require more context, while others should be concise. 

• Highlight that overly lengthy questions can be overwhelming. 

5. Clearly Defined Answer Choices 

• Explain that answer choices should be well-defined. 

• Avoid vague or ambiguous answer options. 

• Encourage participants to consider common misconceptions and address them in answer 

choices. 

Slide Transition 



 

©2024 Public Information Limited, LLC. 

In the next subsection, Subsection 4.1.3, we'll explore "Setting Scoring and Feedback." Participants will 

learn how to set scoring options and provide constructive feedback for quizzes to enhance the learning 

experience. 
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4.2 Result Slides 
Subtitle Providing Feedback and Tracking Progress 

Description: In this subsection, we'll explore how to design and customize result slides in Articulate 

Storyline. Result slides are essential for providing feedback to learners and tracking their quiz 

performance. 

Slide Notes 

• Begin Subsection 4.2 by highlighting the significance of result slides in the eLearning assessment 

process. 

• Explain that result slides offer feedback on quiz performance and help learners track their 

progress. 

• Mention that participants will learn how to create and customize result slides during this section. 

Key Points 

4.2.1. What Are Result Slides? 

• Define result slides as slides that display feedback and performance summary after completing a 

quiz. 

• Explain that result slides provide information on the number of correct/incorrect answers and 

the overall quiz score. 

4.2.2. Designing Result Slides 

• Discuss best practices for designing result slides: 

o Use clear and visually appealing layouts. 

o Include informative feedback messages. 

o Display the learner's score and percentage. 

o Offer options for reviewing quiz questions and answers. 

4.2.3. Customizing Feedback 

• Explain how to customize feedback messages: 

o Create personalized feedback for different score ranges (e.g., Excellent, Good, Needs 

Improvement). 

o Tailor feedback to provide guidance on areas where learners need improvement. 

4.2.4. Scoring and Passing Criteria 

• Discuss how to set scoring and passing criteria:Define the minimum passing score required to 

complete the quiz successfully. 

• Specify what happens when learners meet or fail to meet the passing criteria. 

• Conclude the slide by emphasizing the importance of result slides in providing constructive 

feedback and tracking learner progress. 

Slide Transition 

In the next subsection, Subsection 4.3, we'll explore "Custom Feedback." Participants will learn how to 

provide custom feedback for specific quiz questions, enhancing the learning experience. 
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4.3 Custom Feedback 
Subtitle Enhancing Learner Understanding 

Description: In this subsection, we'll explore the importance of custom feedback in Articulate Storyline 

quizzes. Custom feedback helps learners understand their quiz performance and provides targeted 

insights. 

Slide Notes 

• Begin Subsection 4.3 by emphasizing the value of custom feedback in the learning process. 

• Explain that custom feedback offers specific insights into quiz questions, helping learners 

improve their understanding. 

• Mention that participants will learn how to provide custom feedback for quiz questions during 

this section. 

Key Points 

4.3.1. What Is Custom Feedback? 

• Define custom feedback as personalized comments or explanations provided to learners based 

on their quiz responses. 

• Explain that custom feedback goes beyond generic correct/incorrect messages. 

4.3.2. Benefits of Custom Feedback 

• Discuss the benefits of custom feedback: 

o Helps learners understand why their answer was correct or incorrect. 

o Provides additional context or resources for further learning. 

o Offers a more engaging and tailored learning experience. 

4.3.3. Creating Custom Feedback 

• Explain how to create custom feedback for quiz questions in Articulate Storyline: 

o Access the quiz question properties. 

o Add customized feedback for each answer choice. 

o Use clear and concise language to explain the rationale behind each feedback message. 

4.3.4. Examples of Effective Feedback 

• Provide examples of effective custom feedback: 

o For incorrect answers, explain why the chosen answer is incorrect and provide hints or 

corrections. 

o For correct answers, reinforce the learner's understanding and offer additional insights 

or resources. 

Slide Transition 

In the next subsection, Subsection 4.4, we'll explore "Quiz Review and Retakes." Participants will learn 

how to set up quiz review options and allow learners to retake quizzes for improved performance.  
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Hands on Exercise 4: Create a Quiz with Result Feedback 

Exercise Objective 
In this hands-on exercise, you will create a quiz with result feedback in Articulate Storyline. The quiz will 

consist of multiple-choice questions, and you will customize feedback messages for both correct and 

incorrect answers. 

Instructions 

1. Create a New Quiz Slide 

• Open your Articulate Storyline project. 

• Create a new slide for your quiz. You can do this by going to the "Slides" tab and selecting "New 

Slide." Choose a blank slide template. 

2. Add Quiz Questions 

• Insert multiple-choice quiz questions on the slide. You can add as many questions as you like, but 

for this exercise, let's create three questions. 

• Format each question as follows: 

o Question 1 "What is the capital of France?" 

▪ Choices Paris (Correct), London, Berlin 

o Question 2 "Which gas do plants absorb during photosynthesis?" 

▪ Choices Carbon dioxide (Correct), Oxygen, Nitrogen 

o Question 3 "Who wrote the play 'Romeo and Juliet'?" 

▪ Choices William Shakespeare (Correct), Charles Dickens, Jane Austen 

3. Set Correct Answers 

• Indicate the correct answers for each question: 

o For Question 1, mark "Paris" as the correct answer. 

o For Question 2, mark "Carbon dioxide" as the correct answer. 

o For Question 3, mark "William Shakespeare" as the correct answer. 

4. Customize Feedback Messages 

• For each question, customize the feedback messages for both correct and incorrect answers: 

o For correct answers, provide positive reinforcement and additional information related 

to the question. 

o For incorrect answers, offer helpful hints or explanations to guide learners. 

o Access the question properties and find the feedback options to enter your custom 

messages. 

5. Add a Result Slide 

• After your quiz questions, add a result slide to summarize the learner's performance. 

• Customize the result slide to display the learner's score and feedback based on their quiz 

performance. You can include a message like "Congratulations! You scored [score] out of [total 

possible score]." Customize this message with variables to show the actual score. 

6. Test Your Quiz 

• Preview your quiz to ensure that the questions and custom feedback work as expected. 
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• Interact with the quiz to answer questions and observe the feedback provided. 

7. Save Your Work 

• Save your Articulate Storyline project to keep your quiz and custom feedback settings. 

Conclusion 
By completing this hands-on exercise, you will have created a quiz with custom result feedback in 

Articulate Storyline. This exercise helps you practice designing engaging and informative quizzes that 

provide meaningful feedback to learners based on their performance. 
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Module 5: Publishing and Deployment 
 

Objective: 

 

 

By the end of this module, participants will be skilled in :  

• previewing projects  

• publishing for web and LMS with proper settings  

• exporting for offline viewing, and considering accessibility options for inclusive 

eLearning content  
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5.1 Previewing Your Project 
Subtitle Ensuring Quality 

Description: In this subsection, we'll explore the importance of previewing your Articulate Storyline 

project before publishing. Previewing allows you to ensure the quality and functionality of your 

eLearning content. 

Slide Notes 

• Begin Subsection 5.1 by emphasizing the critical role of project previewing in the eLearning 

development process. 

• Explain that previewing helps identify and resolve issues before the project is published. 

• Mention that participants will learn how to preview their projects effectively during this section. 

Key Points 

5.1.1. Why Preview Your Project? 

• Explain the reasons for previewing your Articulate Storyline project: 

o Ensures that content displays correctly on various devices and browsers. 

o Allows you to test interactivity, navigation, and functionality. 

o Helps identify and correct issues before learners access the content. 

5.1.2. Preview Options 

• Discuss the different preview options available in Articulate Storyline: 

o Preview Slide Preview individual slides to check their appearance and functionality. 

o Preview Scene Preview entire scenes to assess how slides flow together. 

o Project Preview Preview the entire project to test overall navigation and interactivity. 

5.1.3. Interactivity Testing 

• Highlight the importance of testing interactivity during preview: 

o Click all buttons and interactive elements to ensure they work as intended. 

o Test branching scenarios to verify that learners are directed to the correct slides. 

Slide Transition 

In the next subsection, Subsection 5.2, we'll explore "Publishing for Web and LMS." Participants will 

learn how to publish their Articulate Storyline projects for online delivery and integration with Learning 

Management Systems (LMS). 
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5.2 Publishing for Web and LMS 
Subtitle Sharing Your Content 

Description: In this subsection, we'll explore the process of publishing your Articulate Storyline project 

for web delivery and Learning Management System (LMS) integration. Publishing is the final step before 

sharing your eLearning content with learners. 

Slide Notes 

• Begin Subsection 5.2 by highlighting the importance of the publishing process in making 

eLearning content accessible to learners. 

• Explain that publishing involves converting the project into a format that can be easily shared 

and accessed. 

• Mention that participants will learn how to publish their projects for both web delivery and 

integration with LMS platforms during this section. 

Key Points 

5.2.1. Publishing Options 

• Introduce the concept of publishing options in Articulate Storyline: 

o Web Publish the project for web delivery, allowing learners to access it via a web 

browser. 

o LMS Publish the project to be uploaded and managed within a Learning Management 

System. 

5.2.2. Publishing Settings 

• Discuss the settings you can configure during the publishing process: 

o Output Format Choose the appropriate output format (e.g., HTML5) for web 

compatibility. 

o LMS Compatibility Select the LMS standard (e.g., SCORM) that aligns with your LMS 

platform. 

o Reporting and Tracking Determine how the project reports learner progress and 

completion to the LMS. 

5.2.3. Publishing Output 

• Explain that when you publish, Articulate Storyline generates a package of files, including HTML, 

JavaScript, and multimedia assets. 

• Mention that these files can be uploaded to a web server or imported into an LMS, depending 

on your chosen delivery method. 

• Conclude the slide by emphasizing the importance of selecting the right publishing settings for 

the chosen delivery platform. 

Slide Transition 

In the next subsection, Subsection 5.2.1, we'll explore "SCORM Settings." Participants will learn about 

the SCORM standard and how to configure SCORM settings for LMS integration.  
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5.2.4 SCORM Settings 
Subtitle Configuring for LMS Integration 

Description In this subsection, we'll dive into SCORM (Sharable Content Object Reference Model) 

settings in Articulate Storyline. Understanding SCORM is crucial for seamless integration with Learning 

Management Systems (LMS). 

Slide Notes 

• Begin Subsection 5.2.1 by introducing the importance of SCORM settings for LMS integration. 

• Explain that SCORM is a widely used standard for tracking and reporting eLearning interactions. 

• Mention that participants will learn how to configure SCORM settings for their Articulate 

Storyline projects during this section. 

Key Points 

1. What Is SCORM? 

• Define SCORM as a set of technical standards for eLearning content packaging and tracking. 

• Explain that SCORM ensures compatibility and interoperability between eLearning content and 

various LMS platforms. 

2. Configuring SCORM in Articulate Storyline 

• Discuss how to configure SCORM settings in Articulate Storyline: 

o Access the project's publishing settings. 

o Locate the SCORM settings section. 

o Set options such as the SCORM version (e.g., SCORM 1.2, SCORM 2004), completion 

criteria, and pass/fail requirements. 

3. LMS Reporting 

• Explain how SCORM settings affect reporting to the LMS: 

o Completion Status Define how the course marks completion (e.g., after viewing all slides 

or passing a quiz). 

• Reporting Data Specify what data is sent to the LMS (e.g., quiz scores, interaction data). 

• Tracking Progress Determine how the LMS tracks learner progress and completion. 

4. Testing SCORM Packages 

• Highlight the importance of testing SCORM packages in an actual LMS environment. 

• Mention that Articulate Storyline provides options to publish SCORM packages for testing in a 

sandbox or staging LMS environment. 

Slide Transition 

In the next subsection, Subsection 5.2.2, we'll explore "Exporting for Offline Viewing." Participants will 

learn how to export Articulate Storyline content for offline access and distribution.  
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5.3 Exporting for Offline Viewing 
Subtitle Accessibility and Availability 

Description: In this subsection, we'll explore how to export Articulate Storyline content for offline access. 

Offline viewing ensures that learners can access eLearning materials even without a continuous internet 

connection. 

Slide Notes 

• Begin Subsection 5.3 by introducing the concept of exporting eLearning content for offline 

access. 

• Explain that offline access is valuable for learners who may not always have internet 

connectivity. 

• Mention that participants will learn how to export their Articulate Storyline projects for offline 

viewing during this section. 

Key Points 

5.3.1. Why Offline Viewing? 

• Explain the importance of offering offline viewing options for eLearning content: 

o Allows learners to access materials during travel or in remote areas with limited internet 

access. 

o Ensures accessibility for all, including those with intermittent connectivity. 

5.3.2. Exporting Options 

• Discuss the exporting options available in Articulate Storyline: 

o HTML5 Output Exporting the project as HTML5 allows offline viewing through web 

browsers. 

o EXE Output Exporting as an executable file creates a standalone offline version. 

o CD-ROM Output Exporting for CD-ROM distribution provides a physical medium for 

offline access. 

5.3.3. Testing Offline Versions 

• Highlight the importance of testing offline versions: 

o Ensure that all multimedia assets and interactivity work correctly without an internet 

connection. 

o Verify that the offline version mirrors the online experience. 

5.3.4. Distribution Methods 

• Discuss methods for distributing offline versions: 

o Provide downloadable links for HTML5 versions on a website. 

o Share executable files via email or cloud storage. 

o Distribute CD-ROMs or USB drives containing the offline version. 

Slide Transition 
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In the next subsection, Subsection 5.4, we'll explore "Advanced Tips and Resources." Participants will 

learn about advanced eLearning strategies, troubleshooting, and additional resources for continuous 

learning and improvement. 
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5.4 Accessibility Considerations 
Subtitle: Ensuring Inclusivity 

Description: In this subsection, we'll explore the importance of accessibility in eLearning content created 

with Articulate Storyline. Ensuring accessibility is crucial for reaching all learners, including those with 

disabilities. 

Slide Notes: 

• Begin by emphasizing the critical role of accessibility in eLearning design. 

• Explain that accessible eLearning content accommodates individuals with disabilities, ensuring 

equal access to educational materials. 

• Mention that participants will learn about accessibility considerations and best practices during 

this section. 

 

Key Points: 

5.4.1. What Is Accessibility? 

• Define accessibility as the practice of making digital content usable by individuals with 

disabilities. 

• Explain that accessibility encompasses various aspects, including visual, auditory, motor, and 

cognitive accessibility. 

5.4.2. Accessibility Standards 

• Discuss the importance of adhering to accessibility standards, such as the Web Content 

Accessibility Guidelines (WCAG) and Section 508 in the United States. 

• Explain that these standards provide guidelines for creating accessible content. 

5.4.3. Accessibility Features in Articulate Storyline 

• Highlight accessibility features available in Articulate Storyline: 

• Alt Text: Describe how to add descriptive alt text to images for screen readers. 

• Closed Captions: Explain how to include closed captions for video and audio content. 

• Keyboard Navigation: Emphasize the importance of ensuring all interactive elements are 

keyboard accessible. 

5.4.4. Testing for Accessibility 

• Explain the importance of testing eLearning content for accessibility: 

• Use built-in accessibility checkers or third-party tools to assess content. 

• Conduct usability testing with individuals with disabilities for feedback. 

Slide Transition: 

In the next module, Module 6, we'll explore "Advanced Tips and Resources." Participants will learn about 

advanced eLearning strategies, troubleshooting, and additional resources for continuous learning and 

improvement.  
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Hands on Exercise 5: Publish Your Project for Web and Explore Accessibility Options 

Exercise Objective 
In this hands-on exercise, you will publish your Articulate Storyline project for web delivery and explore 

accessibility options. This exercise will help you ensure that your eLearning content is accessible to a 

wide range of learners. 

Instructions 

1. Open Your Articulate Storyline Project 

• Launch Articulate Storyline and open your project file. If you don't have an existing project, you 

can create a simple one for this exercise. 

2. Preview Your Project 

• Before publishing, it's a good practice to preview your project. Click on the "Preview" option to 

check how your project looks and functions. 

3. Access the Publishing Settings 

• Go to the "File" menu and select "Publish." This will open the publishing settings window. 

4. Select Web as the Publishing Option 

• In the publishing settings window, choose "Web" as the publishing option. This will ensure your 

project is ready for online delivery. 

5. Configure Web Publishing Settings 

• Explore the web publishing settings and make selections that align with your project's needs. 

• Pay attention to options like output format (HTML5), quality, and player features. Ensure these 

settings meet your project requirements. 

6. Enable Accessibility Options 

• Look for accessibility options within the publishing settings. Articulate Storyline provides 

features for making your content more accessible. 

• Enable closed captions for any video or audio elements if applicable. 

• Add descriptive alt text to images for screen reader users. Ensure that all multimedia assets are 

accessible to learners with disabilities. 

7. Publish Your Project 

• Once you've configured the settings, click the "Publish" button. Articulate Storyline will generate 

the necessary files for web delivery. 

8. Explore the Published Output 

• After publishing, locate the folder where your project's files were saved. 

• Open the HTML file in a web browser to see how your project appears online. 

• Test interactivity, navigation, and any accessibility features you've enabled. 

9. Verify Accessibility 

• Check the accessibility features you've implemented (e.g., alt text, closed captions) to ensure 

they function as intended. 
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• Use accessibility evaluation tools or assistive technologies (e.g., screen readers) to assess the 

accessibility of your content. 

10. Take Notes 

•  During your exploration, take notes on any issues, improvements, or areas where accessibility 

can be enhanced. 

11. Finalize Your Project 

•  Make any necessary adjustments based on your findings during the exploration. 

•  Save your project to preserve the changes and improvements you've made. 

Conclusion 
By completing this hands-on exercise, you will have published your Articulate Storyline project for web 

delivery and explored accessibility options to ensure that your eLearning content is inclusive and 

accessible to all learners. This exercise helps you practice creating content that meets accessibility 

standards and guidelines. 
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Module 6: Advanced Tips and Resources 
 

Objective: 

 

 

After completing this module, participants will have acquired :  

• best practices and tips for eLearning content development, troubleshooting 

techniques  

• awareness of community and online resources  

• guidance on advancing their Articulate Storyline skills  
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6.1 Best Practices and Tips 
Subtitle: Elevating Your Skills 

Description: In this subsection, we'll delve into best practices and tips for creating engaging and effective 

eLearning content using Articulate Storyline. 

Slide Notes: 

• Begin Subsection 6.1 by highlighting the importance of best practices in eLearning content 

development. 

• Explain that this section will provide participants with valuable tips and techniques to enhance 

their proficiency in using Articulate Storyline effectively. 

Key Points: 
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6.1.1. Content Organization 

• Emphasize the significance of clear and logical content organization: 

o Use a storyboard or outline before starting your project. 

o Create an intuitive navigation structure for learners. 
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6.1.2. Visual Design 

• Discuss principles of effective visual design: 

o Maintain a consistent and visually appealing layout. 

o Use high-quality images and multimedia elements. 

o Pay attention to color choices for readability and accessibility. 
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6.1.3. Interactivity and Engagement 

• Highlight strategies for enhancing learner engagement: 

o Incorporate interactive elements such as quizzes, scenarios, and simulations. 

o Use storytelling techniques to create relatable and engaging narratives. 
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6.1.4. User Experience (UX) 

• Stress the importance of a seamless user experience: 

o Test your project's usability on different devices and browsers. 

o Optimize for mobile responsiveness for learners on smartphones and tablets. 
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6.1.5. Assessment and Feedback 

• Explain the role of assessments and feedback: 

o Design quizzes and assessments that align with learning objectives. 

o Provide constructive feedback to guide learner improvement. 
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6.1.6. Accessibility and Inclusivity 

• Reiterate the importance of accessibility: 

o Ensure your content is accessible to all learners, including those with disabilities. 

o Implement closed captions, alt text, and keyboard navigation. 

  



 

©2024 Public Information Limited, LLC. 

6.1.7. Performance Optimization 

• Discuss techniques for optimizing project performance: 

o Compress multimedia files to reduce loading times. 

o Review and refine triggers and actions for efficiency. 

Slide Transition: 

In the next subsection, Subsection 6.2, we'll explore "Troubleshooting and Common Issues." Participants 

will learn how to identify and resolve common challenges that may arise during eLearning development 

using Articulate Storyline. 
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6.2 Troubleshooting and Common Issues 
Subtitle: Overcoming Challenges 

Description: In this subsection, we'll explore common challenges and troubleshooting techniques for 

resolving issues that may arise during the eLearning development process with Articulate Storyline. 

Slide Notes: 

• Begin Subsection 6.2 by explaining the importance of troubleshooting skills in the eLearning 

development workflow. 

• Let participants know that this section will provide them with valuable strategies and techniques 

for identifying and resolving common issues effectively. 

Key Points: 
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6.2.1. Browser Compatibility 

• Discuss challenges related to browser compatibility: 

o Explain how different web browsers may interpret content differently. 

o Emphasize the importance of testing your project in various browsers and versions. 
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6.2.2. Device Responsiveness 

• Highlight challenges related to device responsiveness: 

o Explain how content may display differently on different devices (e.g., desktop, tablet, 

smartphone). 

o Encourage participants to test their projects on multiple devices and screen sizes. 
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6.2.3. Audio and Video Playback 

• Address common issues with audio and video playback: 

o Explain potential problems such as audio not playing or video not loading. 

o Provide troubleshooting steps, including checking multimedia file formats and codecs. 
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6.2.4. LMS Integration Problems 

• Discuss challenges related to integrating eLearning content with an LMS: 

o Explain issues such as tracking problems or course completion not registering. 

o Provide guidance on configuring SCORM settings and LMS compatibility. 
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6.2.5. Interactivity Errors 

• Explain how interactivity errors can affect the learner experience: 

o Discuss issues like triggers not working or buttons not responding. 

o Offer troubleshooting tips, such as reviewing trigger conditions and actions. 
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6.2.6. File Size and Performance 

• Address concerns related to file size and performance: 

o Explain how large multimedia files can impact loading times. 

o Provide optimization techniques like compressing images and videos. 

Slide Transition: 

In the next subsection, Subsection 6.3, we'll explore "Community and Online Resources." Participants 

will learn about online communities, forums, and resources where they can seek help, share knowledge,   
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6.3 Community and Online Resources 
Subtitle: Collaborative Learning 

Description: In this subsection, we'll explore the benefits of engaging with the Articulate Storyline 

community and utilizing online resources to enhance your eLearning development skills. 

Slide Notes: 

• Begin Subsection 6.3 by emphasizing the value of community engagement and online resources 

in professional development. 

• Explain that this section will introduce participants to various avenues for seeking help, sharing 

knowledge, and collaborating with other Articulate Storyline users. 

Key Points: 

  



 

©2024 Public Information Limited, LLC. 

6.3.1. eLearning Heroes Community 

• Introduce the eLearning Heroes community: 

o Explain that it's a vibrant online community hosted by Articulate, where eLearning 

professionals share expertise and resources. 

o Emphasize the value of participating in discussions, asking questions, and sharing your 

knowledge. 
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6.3.2. Discussion Forums 

• Discuss the significance of discussion forums: 

o Mention that there are various discussion forums and groups dedicated to Articulate 

Storyline on platforms like LinkedIn and Reddit. 

o Encourage participants to join relevant groups and actively engage in discussions. 
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6.3.3. Online Courses and Tutorials 

• Highlight the availability of online courses and tutorials: 

o Explain that there are numerous online courses and tutorials on Articulate Storyline 

available on eLearning platforms. 

o Recommend popular platforms or specific courses that participants can explore for in-

depth learning. 
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6.3.4. Blogs and Blogsphere 

• Mention the presence of blogs and bloggers focused on eLearning and Articulate Storyline: 

o Suggest following influential bloggers and subscribing to eLearning-related blogs for 

insights and updates. 

o Encourage participants to consider starting their own blogs to share their experiences 

and expertise. 

Slide Transition: 

In the next subsection, Subsection 6.4, we'll discuss "Next Steps and Advanced Training." Participants will 

learn about advanced training options, certification, and opportunities for further specialization in 

Articulate Storyline. 
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6.4 Next Steps and Advanced Training 
Subtitle: Continuing Your Journey 

Description: In this subsection, we'll explore the opportunities for advancing your skills in Articulate 

Storyline, including advanced training, certification, and specialization. 

Slide Notes: 

• Begin Subsection 6.4 by highlighting the importance of continuous skill development and career 

growth. 

• Explain that this section will provide participants with insights into how they can take their 

proficiency in Articulate Storyline to the next level. 

Key Points: 

6.4.1. Advanced Training Programs 

• Introduce the concept of advanced training programs: 

o Mention that many training providers offer advanced courses specifically designed to 

deepen your Articulate Storyline skills. 

o Recommend renowned training programs or providers participants can explore. 

6.4.2. Certification Opportunities 

• Discuss the significance of certification in validating your expertise: 

o Explain that Articulate Storyline offers certification programs that can boost your 

credibility. 

o Mention the benefits of becoming a certified Articulate Storyline developer. 

6.4.3. Specialization Tracks 

• Highlight the option to specialize in specific areas: 

o Discuss the benefits of specializing in areas such as accessibility compliance, mobile 

learning, or gamification. 

o Encourage participants to consider which specialization aligns with their career goals. 

6.4.4. Professional Networking 

• Emphasize the value of professional networking: 

o Encourage participants to attend industry conferences, webinars, and workshops. 

o Mention the benefits of building a professional network for career opportunities and 

knowledge exchange. 

Slide Transition: 

In the next subsection, we'll wrap up the course with a "Recap of Key Concepts," an "Open Q&A for 

Participants," and a "Course Evaluation and Feedback" session. 
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Hands on Exercise 6: Share Your Project with Peers for Feedback 

Exercise Objective: 
In this hands-on exercise, you will have the opportunity to share your Articulate Storyline project with 

peers to gather valuable feedback. Peer feedback is a crucial step in improving the quality of your 

eLearning content. 

Instructions: 

1. Prepare Your Project for Sharing: 

Open your Articulate Storyline project file. Ensure that it's in a state ready for review by your peers. 

Check that all multimedia elements, interactivity, and navigation are functioning as intended. 

2. Create a Feedback Form or Questionnaire: 

Design a feedback form or questionnaire that your peers can use to provide structured feedback. Include 

questions about the content, usability, and overall learning experience. 

3. Select Peer Reviewers: 

Identify a group of peers or colleagues who can provide constructive feedback on your project. These 

individuals should ideally have some familiarity with eLearning development. 

4. Distribute Your Project and Feedback Form: 

Share your Articulate Storyline project file with the selected peer reviewers. You can use cloud storage, 

email, or collaboration platforms for this purpose. 

Also, share the feedback form or questionnaire you created with clear instructions on how to use it. 

5. Set a Review Deadline: 

Establish a reasonable deadline by which your peer reviewers should provide feedback. This ensures 

timely responses. 

6. Review Peer Feedback: 

Collect the feedback from your peer reviewers as it comes in. Organize and review the feedback 

systematically. 

7. Analyze and Implement Suggestions: 

Analyze the feedback received and identify common themes, suggestions, and areas for improvement. 

Prioritize the suggested changes based on their impact on the project's quality and learning outcomes. 

8. Make Revisions to Your Project: 

Use the feedback to make necessary revisions and improvements to your Articulate Storyline project. 

Ensure that the changes align with your project's learning objectives and content goals. 

9. Re-Share the Updated Project (Optional): 

If you wish, you can re-share the updated project with your peer reviewers for a final review to confirm 

that the suggested improvements have been implemented. 
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10. Thank Your Peer Reviewers: 

 Express your gratitude to your peer reviewers for their time and valuable input. Acknowledge their 

contributions to the project's enhancement. 

Conclusion: 
By completing this hands-on exercise, you will have experienced the benefits of peer feedback in 

improving your Articulate Storyline project. Peer review is an essential step in the quality assurance 

process, ensuring that your eLearning content meets its learning objectives and provides an engaging 

learning experience. 
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Wrap Up and Q&A Session 
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Recap of Key Concepts 
Subtitle: Reinforcing Your Learning 

Description: In this section, we'll summarize the key concepts covered throughout this Articulate 

Storyline Intermediate Level Course to reinforce your learning. 

Slide Notes: 

• Begin the "Recap of Key Concepts" section by acknowledging the progress participants have 

made in learning Articulate Storyline. 
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Key Concepts Covered: 

1. Introduction to Articulate Storyline: 

• Recap the basics of Articulate Storyline and its interface. 

• Highlight the significance of project properties, story size, and publishing options. 

2. Building Your First Slide: 

• Emphasize the importance of text, images, media, shapes, buttons, layers, and states in creating 

interactive slides. 

3. Storyline's Powerful Features: 

• Revisit triggers, actions, and variables for creating interactivity. 

• Explain the use of slide transitions and animations. 

4. Assessments and Quizzes: 

• Summarize the creation of quizzes, question types, and result slides. 

• Stress the value of custom feedback for learner engagement. 

5. Publishing and Deployment: 

• Reiterate the steps for previewing, publishing for web and LMS, exporting for offline viewing, 

and accessibility considerations. 

6. Advanced Tips and Resources: 

• Review best practices, troubleshooting techniques, and resources for continuous learning and 

improvement. 

7. Community and Online Resources: 

• Summarize the importance of engaging with the Articulate Storyline community and utilizing 

online resources for support and growth. 

8. Next Steps and Advanced Training: 

• Discuss options for advancing skills through advanced training, certification, specialization, and 

professional networking. 
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Interactive Recap Activity: 

• To make the recap engaging, consider using an interactive activity like a quiz or a game where 

participants can test their knowledge of the key concepts covered in the course. 
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Q&A Session: 

• Open the floor for any questions or clarifications on the key concepts. Address any queries or 

concerns participants may have. 
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Closing Remarks: 

• Thank participants for their active participation and commitment to learning Articulate Storyline. 

• Encourage them to continue practicing and exploring the software to become proficient 

eLearning developers. 

• Mention that they can refer back to course materials and resources whenever needed. 

Slide Transition: 

Transition to the final section of the course, which includes a "Course Evaluation and Feedback" session. 

Invite participants to provide feedback on the course content and delivery to help improve future 

training. 
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Open Q&A for Participants 
Subtitle: Your Chance to Clarify Doubts 

Description: In this section, we'll open the floor for participants to ask questions, seek clarifications, and 

discuss any challenges or topics related to Articulate Storyline. 

Slide Notes: 

• Begin the "Open Q&A for Participants" section by welcoming participants to ask any questions 

they may have related to the course content, Articulate Storyline, or eLearning development. 

How the Q&A Session Will Work: 

• Explain the format of the Q&A session: 

o Participants can ask questions by raising their hand, using the chat feature, or submitting 

questions in advance. 

o Questions will be addressed one by one, and participants are encouraged to share their 

insights or experiences as well. 

Facilitate the Q&A: 

• As participants pose questions, respond to each question thoughtfully and provide clear and 

helpful answers. 

• Encourage participants to share their thoughts or solutions if they have relevant experiences to 

contribute. 

Topics to Address: 

• Be prepared to address a wide range of topics, including but not limited to: 

o Specific Articulate Storyline features or functionalities. 

o Troubleshooting challenges participants are facing. 

o Advice on best practices for eLearning development. 

o Recommendations for additional resources or advanced training. 

 

Wrap-Up: 

• Conclude the Q&A session by thanking participants for their active engagement and questions. 

• Invite participants to reach out after the course if they have further questions or need additional 

support. 

Slide Transition: 

Transition to the final section of the course, which includes a "Course Evaluation and Feedback" session. 

Encourage participants to provide feedback on the course content, delivery, and the Q&A session to help 

improve future training.  
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Course Evaluation and Feedback 
Subtitle: Your Input Matters 

Description: In this section, we'll invite participants to provide feedback on the course content, delivery, 

and overall learning experience. Your input helps us improve future training. 

Slide Notes: 

• Begin the "Course Evaluation and Feedback" section by emphasizing the importance of 

participant feedback in enhancing the quality of the course. 
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Course Evaluation Form: 

• Share that a course evaluation form has been prepared, which will be shared with participants. 

• Explain that the form will cover various aspects of the course, including content, delivery, 

materials, and organization. 

 

Instructions for Completing the Evaluation: 

• Provide instructions on how participants can access and complete the evaluation form: 

o Share the link or method for accessing the form. 

o Specify the deadline for completing the evaluation. 

 

Encourage Honest and Constructive Feedback: 
Emphasize that honest and constructive feedback is highly valued. Participants' input will be used to 

make improvements and enhancements to future training. 

 

Final Remarks: 

• Thank participants for their active participation in the course. 

• Express gratitude in advance for their valuable feedback. 

• Encourage participants to stay connected and explore additional resources for continuous 

learning in Articulate Storyline. 

Slide Transition: 

Transition to the course conclusion and thank participants for their participation and feedback. 


